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Printable PDF Vector Map San Francisco + Oakland California US, exact City Plan scale 1:59463 full editable Adobe PDF Street Map in layers, scalable, editable text format  street names, 14 mb ZIP
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The most exact and detailed map of the city.

For High Quality Printing Large or Small format.
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San Francisco, California, USA.

This vector map of San Francisco city is used as a basis for design, editing, and further printing.

This is the most detailed, exact map of San Francisco city for high-quality printing and polygraphy. You can always clarify the map development date by contacting us.

For your convenience, all objects on San Francisco vector city map are divided into layers. And the editing is very easy – colors, lines, etc.

You can easily add any objects needed (e.g. shops, salons, sale points, gas station or attraction) on any layer of San Francisco vector map.

San Francisco, officially the City and County of San Francisco, is the cultural, commercial, and financial center of Northern California. San Francisco is the 13th most populous city in the United States, and the 4th most populous in California, with 884,363 residents as of 2017. It covers an area of about 46.89 square miles (121.4 km2), mostly at the north end of the San Francisco Peninsula in the San Francisco Bay Area, making it the second most densely populated large US city, and the fifth most densely populated U.S. county, behind only four of the five New York City boroughs.



One of the advantages of San Francisco city vector maps of our production is the relevance of cartographic data, we constantly update all our products.

This vector map of San Francisco city is used by:

designers, layout designers, printers, advertisers and architects. Our product – vector maps – is designed for further editing and printing in large formats – from @Wall format (a few meters) to A-0 and A-1, A-2, A-3.

The San Francisco city map in vector format is used for design, urban planning, presentations and media visualizations.

The advertising and presentation map of San Francisco city (usually the final designer marks the routes, and puts the client’s objects (shops, saloons, gas stations etc.)

The undoubted advantage is that people will NEVER throw out this advertising product – the map. In fact, as an advertising medium, a city map is the most “long-playing” of the well-known polygraphic advertising media, with the longest lifespan, and the maximum number of interactions with the customer.

For travelers, maps are sold at the airports and gas stations around the world. Often the source is our vector maps.

Take a look, who purchases our vector maps of San Francisco city in “Our Clients and Friends” page – these are large and small companies, from super-brands like Volvo and Starbucks, to small design studios and printing houses.

It’s very easy to work with vector maps of San Francisco city, even for a not very experienced designer who can turn on and off the map layers, add new objects, change the colors of fill and lines according to customer requirements.



The undoubted advantage of San Francisco city vector maps in printing is an excellent and detailed visualization, when customer can expand a large paper map and instantly define his location, find a landmark, an object or address on map, unlike using the popular electronic formats of Google and Yandex maps for example.

Printable vector maps of San Francisco city are much more convenient and efficient than any electronic maps on your smartphone, because ALL DETAILS are displayed in the entire space of San Francisco city map.

Useful tips on working with vector maps of cities and countries in Adobe Illustrator.

«V» – launches the Selection tool (cursor, black arrow), which makes active any vector line.

«А» – launches the Direct Selection tool (white cursor), allows you to select curve elements and drag them to the desired place.

«R» – activates the Rotate tool, which helps you rotating selected objects around the center point by 360 degrees.

«E» – gives you the opportunity to use the Eraser tool and erase unnecessary parts.

«X» – switches between Fill and Stroke in the Tools section. Try to get used to this hot key and

you will quickly understand that you can’t live and work without it.

San Francisco is also part of the fifth most populous primary statistical area in the United States, the San Jose–San Francisco–Oakland, CA Combined Statistical Area (8.8 million residents).

As of 2017, it was the 7th highest-income county in the United States, with a per capita personal income of $119,868. The San Francisco CSA was the country’s 3rd largest urban economy as of 2017, with a GDP of $878 billion. Of the 574 primary statistical areas in the US, the San Francisco CSA had the highest GDP per capita in 2017, at $99,347 per capita. San Francisco was ranked 14th in the world and third in the United States on the Global Financial Centres Index as of September 2018.



Guides are not limited to vertical and horizontal in Adobe Illustrator. You can also create a diagonal guide for example. Moreover, you can turn any contours into guides. Select the outline and go to View > Guides > Make Guides (Create Guides), or simply press Cmd/Ctrl + 5. You can also turn the guides back into an editable object. Go to menu, View > Guides > Unlock Guides (Release Guides), select the guide you want to edit and select View > Guides > Release Guides (Reset Guides), or just press Cmd/Ctrl + Option / Alt + 5).

You will probably want to change the color scheme used on our San Francisco vector city map.

To quickly and effectively play with colors.

Of course, you can do it manually, all objects in our San Francisco city vector map are divided according to types and layers, and you can easily change the color gamma of vector objects in groups and layers.

San Francisco was founded on June 29, 1776, when colonists from Spain established Presidio of San Francisco at the Golden Gate and Mission San Francisco de Asís a few miles away, all named for St. Francis of Assisi. The California Gold Rush of 1849 brought rapid growth, making it the largest city on the West Coast at the time.



But there is more effective way of working with the whole VECTOR MAP of San Francisco city and all layers:

The overview dialog «Edit colors»/«Repaint Graphic Object» (this dialog box name can change depending on the context):

If you have selected a part or a layer of San Francisco city vector map and open the dialog box by clicking the icon in the Control panel, on the Samples palette or the Color Catalog, or if you choose Edit > Edit Colors> Repaint Graphic Object, then the «Repaint Graphic Object» dialog box appears, and you get access to «Assign» and «Edit» tabs.

If a picture or a map fragment is not selected, and you open the dialog box by clicking the icon in the Control panel, on the Samples palette or in the Color Catalog, the «Edit Colors» dialog box appears and you can only access the «Edit» tab.

Regardless of the name at the top of the dialog box, the right-hand side always displays the color group of the current document, as well as two default color groups: Print Color and Grayscale. These color groups can be selected and used any time.

San Francisco became a consolidated city-county in 1856. San Francisco’s status as the West Coast’s largest city peaked between 1870 and 1900, when around 25% of California’s population resided in the city. After three-quarters of the city was destroyed by the 1906 earthquake and fire, San Francisco was quickly rebuilt, hosting the Panama-Pacific International Exposition nine years later. In World War II, San Francisco was a major port of embarkation for service members shipping out to the Pacific Theater. It then became the birthplace of the United Nations in 1945.



Create and edit color groups of San Francisco city vector map, and also assign colors using the «Edit Colors»/ а «Repaint Graphic Object» dialog box.

A. Creating and editing of a color group on the «Edit» tab

B. Assigning colors on the «Assign» tab

C. Select a group of colors from the «Color groups» list

The option «Repaint a graphic object» in the lower part of the dialog box allows you to preview the colors on a selected layer of Vector map, or a group of elements, and specify whether its colors will be redefined when the dialog box is closed.

After the war, the confluence of returning servicemen, significant immigration, liberalizing attitudes, along with the rise of the “hippie” counterculture, the Sexual Revolution, the Peace Movement growing from opposition to United States involvement in the Vietnam War, and other factors led to the Summer of Love and the gay rights movement, cementing San Francisco as a center of liberal activism in the United States. Politically, the city votes strongly along liberal Democratic Party lines.



The main areas of the dialog box are:

«Edit»

The «Edit» tab is designed to create a new or edit the existing color groups.

The harmony rules Menu and the Color Wheel are used to conduct experiments with color harmonies. The color wheel shows how colors are related in color harmony, and the color bars allow you to view and manipulate an individual color values. In addition, you can adjust the brightness, add and remove colors, save color groups and view colors on the selected Vector Map of San Francisco city or a separated layers.

«Assign»

The «Assign» tab is used to view and control on how the original colors are replaced with colors from the color group like your corporate colors in the Vector Map of San Francisco city.

A popular tourist destination, San Francisco is known for its cool summers, fog, steep rolling hills, eclectic mix of architecture, and landmarks, including the Golden Gate Bridge, cable cars, the former Alcatraz Federal Penitentiary, Fisherman’s Wharf, and its Chinatown district. San Francisco is also the headquarters of five major banking institutions and various other companies such as Levi Strauss & Co., Gap Inc., Fitbit, Salesforce.com, Dropbox, Reddit, Square, Inc., Dolby, Airbnb, Weebly, Pacific Gas and Electric Company, Yelp, Pinterest, Twitter, Uber, Lyft, Mozilla, Wikimedia Foundation, Craigslist, and Weather Underground. It is home to a number of educational and cultural institutions, such as the University of San Francisco (USF), University of California, San Francisco (UCSF), San Francisco State University (SFSU), the De Young Museum, the San Francisco Museum of Modern Art, and the California Academy of Sciences.



The assign color ability is provided only if the entire map, layer or fragment is selected in the document. You can specify which of new colors replace the current colors, whether the spot colors should be preserved and how colors are replaced (for example, you can replace colors completely or changing the color tone while maintaining the brightness). The «Assign» tab allows you to redefine colors in the Vector Map of San Francisco city, or in separate layers and fragments using the current color group or reducing the number of colors in the current Vector Map.

Color groups

Is a list of all saved color groups for current document (the same groups appear in the «Samples» palette). You can edit and delete the existing color groups, as well as creating a new ones using the list of “Color Groups” in the dialog box. All changes appear in the «Samples» palette.

The highlighted color group shows, which color group is currently edited.



Any color group can be selected and edited, or used to redefine the colors in the selected vector map of San Francisco city, its fragments or elements.

Saving a color group adds this group to the specified list.

Opening the «Edit Colors»/«Repaint Graphic Object» dialog box.

Open the «Edit Colors»/«Repaint Graphic Object» dialog box using one of the following methods:

«Edit»> «Edit Colors»> «Repaint Graphic object» or «Repaint With Style».

Use these commands if you need to edit the colors in the selected vector map of San Francisco city.

«Repaint Graphic object» button on the «Control» panel.

Use this button if you need to adjust colors of San Francisco city vector map using the а «Repaint graphic object» dialog box.

As of 2018, San Francisco is the highest rated American city on world liveability rankings.

Geography

San Francisco is located on the West Coast of the United States at the north end of the San Francisco Peninsula and includes significant stretches of the Pacific Ocean and San Francisco Bay within its boundaries. Several picturesque islands—Alcatraz, Treasure Island and the adjacent Yerba Buena Island, and small portions of Alameda Island, Red Rock Island, and Angel Island—are part of the city. Also included are the uninhabited Farallon Islands, 27 miles (43 km) offshore in the Pacific Ocean. The mainland within the city limits roughly forms a “seven-by-seven-mile square”, a common local colloquialism referring to the city’s shape, though its total area, including water, is nearly 232 square miles (600 km2).



The specified button is available if the selected vector map or its fragment contains two or more colors.

Note. This color editing method is convenient for global color adjustment in a vector map, if global colors were not used when creating a City Map of San Francisco.

The «Edit colors» button or «Edit or apply colors» on the «Color Catalog» palette

Click this button if you need to edit colors on the «Color Catalog» palette or edit and then apply them to the selected Vector Map of San Francisco city or its fragment.

The «Edit color group» button or «Edit or apply color group» on the «Samples» palette.



Click this button if you need to edit the colors in the specific color group or edit and apply them to the selected Vector Map of San Francisco city or a group of its elements, for example, the whole layer “Streets and lines”. You can also double-click the color group in the Samples panel to open the dialog box.

If the map file is too large and your computer freezes or even can’t open it quickly:

1. Try to reduce the color resolution of the video card (display) to 256 colors while working with a large map.

2. Using Windows Task Manager, select all the application you don’t need, while working with map, just turn them off.

3. Launch Adobe Illustrator. (DO NOT OPEN the vector map file)

4. Start the Windows Task Manager using administrator rights > Find the “Illustrator” process > set the «real time» priority,

5. Open the file. When you see the LEGACY FONT popup window – click “OK” (do not update). You can restore the TEXT later.

6. Can also be useful: When file is opened – Edit > Settings > Basic Settings > disable smoothing. /// It looks scary, but works quickly)))

We recommend saving the file in Adobe Illustrator 10 version. It’s much more stable when working with VERY BIG size files.

There are more than 50 hills within city limits. Some neighborhoods are named after the hill on which they are situated, including Nob Hill, Potrero Hill, and Russian Hill. Near the geographic center of the city, southwest of the downtown area, are a series of less densely populated hills. Twin Peaks, a pair of hills forming one of the city’s highest points, forms a popular overlook spot. San Francisco’s tallest hill, Mount Davidson, is 928 feet (283 m) high and is capped with a 103-foot (31 m) tall cross built in 1934. Dominating this area is Sutro Tower, a large red and white radio and television transmission tower.

The nearby San Andreas and Hayward Faults are responsible for much earthquake activity, although neither physically passes through the city itself. The San Andreas Fault caused the earthquakes in 1906 and 1989. Minor earthquakes occur on a regular basis. The threat of major earthquakes plays a large role in the city’s infrastructure development. The city constructed an auxiliary water supply system and has repeatedly upgraded its building codes, requiring retrofits for older buildings and higher engineering standards for new construction. However, there are still thousands of smaller buildings that remain vulnerable to quake damage. USGS has released the California earthquake forecast which models earthquake occurrence in California.

San Francisco’s shoreline has grown beyond its natural limits. Entire neighborhoods such as the Marina, Mission Bay, and Hunters Point, as well as large sections of the Embarcadero, sit on areas of landfill. Treasure Island was constructed from material dredged from the bay as well as material resulting from the excavation of the Yerba Buena Tunnel through Yerba Buena Island during the construction of the Bay Bridge. Such land tends to be unstable during earthquakes. The resulting soil liquefaction causes extensive damage to property built upon it, as was evidenced in the Marina district during the 1989 Loma Prieta earthquake. Most of the city’s natural watercourses, such as Islais Creek and Mission Creek, have been culverted and built over, although the Public Utilities Commission is studying proposals to daylight or restore some creeks.

Neighborhoods

The historic center of San Francisco is the northeast quadrant of the city anchored by Market Street and the waterfront. It is here that the Financial District is centered, with Union Square, the principal shopping and hotel district, and the Tenderloin nearby. Cable cars carry riders up steep inclines to the summit of Nob Hill, once the home of the city’s business tycoons, and down to the waterfront tourist attractions of Fisherman’s Wharf, and Pier 39, where many restaurants feature Dungeness crab from a still-active fishing industry. Also in this quadrant are Russian Hill, a residential neighborhood with the famously crooked Lombard Street; North Beach, the city’s Little Italy and the former center of the Beat Generation; and Telegraph Hill, which features Coit Tower. Abutting Russian Hill and North Beach is San Francisco’s Chinatown, the oldest Chinatown in North America. The South of Market, which was once San Francisco’s industrial core, has seen significant redevelopment following the construction of AT&T Park and an infusion of startup companies. New skyscrapers, live-work lofts, and condominiums dot the area. Further development is taking place just to the south in Mission Bay area, a former railroad yard, which now has a second campus of the University of California, San Francisco, and where the new Warriors arena will be built. West of downtown, across Van Ness Avenue, lies the large Western Addition neighborhood, which became established with a large African American population after World War II. The Western Addition is usually divided into smaller neighborhoods including Hayes Valley, the Fillmore, and Japantown, which was once the largest Japantown in North America but suffered when its Japanese American residents were forcibly removed and interned during World War II. The Western Addition survived the 1906 earthquake with its Victorians largely intact, including the famous “Painted Ladies”, standing alongside Alamo Square. To the south, near the geographic center of the city is Haight-Ashbury, famously associated with 1960s hippie culture. The Haight is now home to some expensive boutiques and a few controversial chain stores, although it still retains some bohemian character.

Skyscrapers are common in northeast San Francisco, the city’s downtown

North of the Western Addition is Pacific Heights, an affluent neighborhood that features the homes built by wealthy San Franciscans in the wake of the 1906 earthquake. Directly north of Pacific Heights facing the waterfront is the Marina, a neighborhood popular with young professionals that was largely built on reclaimed land from the Bay.

In the south-east quadrant of the city is the Mission District—populated in the 19th century by Californios and working-class immigrants from Germany, Ireland, Italy, and Scandinavia. In the 1910s, a wave of Central American immigrants settled in the Mission and, in the 1950s, immigrants from Mexico began to predominate. In recent years, gentrification has changed the demographics of parts of the Mission from Latino, to twenty-something professionals. Noe Valley to the southwest and Bernal Heights to the south are both increasingly popular among young families with children. East of the Mission is the Potrero Hill neighborhood, a mostly residential neighborhood that features sweeping views of downtown San Francisco. West of the Mission, the area historically known as Eureka Valley, now popularly called the Castro, was once a working-class Scandinavian and Irish area. It has become North America’s first and best known gay village, and is now the center of gay life in the city. Located near the city’s southern border, the Excelsior District is one of the most ethnically diverse neighborhoods in San Francisco. The predominantly African American Bayview-Hunters Point in the far southeast corner of the city is one of the poorest neighborhoods and suffers from a high rate of crime, though the area has been the focus of several revitalizing and controversial urban renewal projects.

The construction of the Twin Peaks Tunnel in 1918 connected southwest neighborhoods to downtown via streetcar, hastening the development of West Portal, and nearby affluent Forest Hill and St. Francis Wood. Further west, stretching all the way to the Pacific Ocean and north to Golden Gate Park lies the vast Sunset District, a large middle class area with a predominantly Asian population. The northwestern quadrant of the city contains the Richmond, also a mostly middle-class neighborhood north of Golden Gate Park, home to immigrants from other parts of Asia as well as many Russian and Ukrainian immigrants. Together, these areas are known as The Avenues. These two districts are each sometimes further divided into two regions: the Outer Richmond and Outer Sunset can refer to the more western portions of their respective district and the Inner Richmond and Inner Sunset can refer to the more eastern portions.

Many piers remained derelict for years until the demolition of the Embarcadero Freeway reopened the downtown waterfront, allowing for redevelopment. The centerpiece of the port, the Ferry Building, while still receiving commuter ferry traffic, has been restored and redeveloped as a gourmet marketplace.

List of neighborhoods in San Francisco

San Francisco, in the US state of California, has both major, well-known neighborhoods and districts as well as smaller, specific subsections and developments. While there is considerable fluidity among the sources, one guidebook identifies five major districts, corresponding to the four quadrants plus a south central district. These five broad districts, counterclockwise are: Central/downtown, Richmond, Sunset, Upper Market and beyond (south central) and Bernal Heights/Bayview and beyond (southeast). Within each of these five districts are located major neighborhoods, and again there is considerable fluidity seen in the sources. The San Francisco Planning Department officially identifies 36 neighborhoods. Within these 36 official neighborhoods are a large number of minor districts, some of which are historical, and some of which are overlapping.

Alamo Square

Alamo Square is a subset of the Western Addition neighborhood. Its boundaries are not well-defined, but are generally considered to be Webster Street on the east, Golden Gate Avenue on the north, Divisadero Street on the west, and Oak Street on the south. It is characterized by Victorian archtecture that was left largely untouched by the urban renewal projects in other parts of the Western Addition. On a clear day, the Transamerica Pyramid building and the tops of the Golden Gate Bridge and Bay Bridge can be seen from the park’s center. San Francisco’s City Hall can be seen directly down Fulton Street. A row of Victorian houses facing the park on Steiner Street, known as the painted ladies, are often shown in the foreground of panoramic pictures of the city’s downtown area.

Ashbury Heights

Ashbury Heights is a neighborhood on the hill to the south of the Haight-Ashbury neighborhood. It is at the base of Tank Hill and neighboring Cole Valley.

Balboa Park

Balboa Terrace

Balboa Terrace is a small residential neighborhood in southwestern San Francisco bounded by Junipero Serra Boulevard, Monterey Avenue, Aptos Avenue and Ocean Avenue along the southern edge of the exclusive St. Francis Wood development.

Bayview

The Bayview stretches along Third Street south of Evans Avenue, west of the Hunters Point neighborhood. The neighborhood library was recently renamed the Linda Brooks-Burton Branch Library after a new and larger building was constructed at the same location on Third Street and Revere. Within a block or two of the library are three urban gardens and public art projects, developed entirely by residents, known as the Quesada Gardens Initiativ (the Quesada Garden, Bridgeview Garden, and Latona Garden). The Bayview is known for its friendly and diverse residents, warm weather and inviting vistas, community gardens, independent businesses, artists’ community, and rich history as an African American and working-class neighborhood. During the 1950s it was largely a Maltese and Italian neighborhood, centered on St. Paul of the Shipwreck Church and the Maltese American Social Club, both on Oakdale Ave. The area is served by the T-Third light rail line, and is home to the Bayview Opera House and City College Evans and Southeast Campus. The area is undergoing rapid development as the City tries to meet the demands of population growth and corporate investors have revalued the relatively large amount of buildable land. Hunters Point Shipyard and Candlestick Park areas are primary centers of development in the neighborhood. Despite its diversity, residents have a long history of coming together to create change and protect neighborhood assets. Bayview Footprints Network is telling a positive story about an often maligned place and maintains the neighborhood’ longest-running blog, and the Bay View Newspaper is a respected voice for the underserved. Hunters Point Shipyard, a former Super-Fund site, and a polluting power plant have been focal points for environmental activists. Elders remember when, during the civil rights era, the neighborhood was one of the most highly organized, led by social justice advocates such as Julia Commer, Osceola Washington, Ruth Williams, Rosie Williams and Eloise Westbrook, Essie Webb, Espanola Jackson, Shirley Jones, Alex Pitcher, and many others. Sam Jordan, boxing champion and tavern owner, was the first African American to run for Mayor of San Francisco.

Belden Place

A small neighborhood near the Financial District, being the historical location of the French Quarter in San Francisco.

Bernal Heights

Bernal Heights is a neighborhood perched on a hill in between the Mission district, Bayview, and the Portola district. The neighborhood is known for its community feeling and progressive vibe. The majority of the neighborhood is white, but there are significant Southern Italian, Latino and African American populations in the area as well. The main shopping area in Bernal Heights is Cortland Avenue, with a variety of storefronts that include a health food store, a community center, a yoga studio, bars, bakeries, and restaurants. Many of the quaint, hilly streets in the neighborhood are so narrow that two cars cannot pass in opposite directions without one car pulling over to the side of the road.

Buena Vista

The Buena Vista neighborhood surrounds Buena Vista Park, south of the Haight-Ashbury neighborhood. Market Street is to the south, and Corona Heights Park and neighborhood is to the east.

Butchertown (Old and New)

Butchertown (New) (see Islais Creek) is an industrial neighborhood in San Francisco that historically housed the city’s slaughterhouses. It is one of the few remaining industrial sectors of San Francisco. Originally, Butchertown extended into the neighborhood now known as Dogpatch. Today’s street borders are Cesar Chavez to the north, Interstate 280 to the west, Industrial Street and Oakdale Avenue to the south, and 3rd Street to the east. There are still two meat rendering plants in the neighborhood, and until pollution control measures were taken in 1995 the stench was still quite apparent. Butchertown is also headquarters to San Francisco’s only active freight railroad, the San Francisco Bay Railroad, a Class 3 short-line carrier.

 

San Francisco

City in California

San Francisco, in northern California, is a hilly city on the tip of a peninsula surrounded by the Pacific Ocean and San Francisco Bay. It’s known for its year-round fog, iconic Golden Gate Bridge, cable cars and colorful Victorian houses. The Financial District’s Transamerica Pyramid is its most distinctive skyscraper. In the bay sits Alcatraz Island, site of the notorious former prison.

Area

• City and county 231.89 sq mi (600.59 km2)

• Land 46.89 sq mi (121.46 km2)

• Water 185.00 sq mi (479.14 km2) 80.00%

• Metro 3,524.4 sq mi (9,128 km2)

Elevation 52 ft (16 m)

Highest elevation 934 ft (285 m)

Lowest elevation 0 ft (0 m)

Population

• City and county 884,363

• Rank 4th in California

13th in United States

• Density 18,860/sq mi (7,282/km2)

• Metro 4,727,357 (12th)

• CSA 8,837,789 (5th)
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Map for design, projects, presentation free to use as you like.

See also: TERMS & CONDITIONS: SOFTWARE LICENSE AGREEMENT FOR DIGITAL CARTOGRAPHIC DATA.

Need more USA Vector Maps, printable and editable?


Author: Kirill Shrayber, Ph.D.

I have been working with vector cartography for over 25 years, including GPS, GIS, Adobe Illustrator and other professional cartographic software.

Linkedin: https://www.linkedin.com/in/kirill-shrayber-0b839325/

Twitter: https://twitter.com/vectormapper
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651 N Broad St Suite 201

Middletown, DE US
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